LARGEST

0333 6000 600 {

INLEC.COM




TEST EQUIPMENT

HiRE THiS PRODUCT NOW

WWW.INLEC.COM
FREEPHONE 0800 052 1110

oW W oW oW W ow

CONTENTS PAGE
1 INTRODUCTION ..., 2
1.1 System Requirements ........................... 4
2 INSTALLATION.........coooiiiies 4
2.1 Installing the software ..................ccc... 4
2.2 Instrument connection .............c.coeevvenens 4
2.3 Starting PQLog Setup....cccceeeeeeeeiccnnnnee. 4
2.4 Selecting the serial port_........................ 4
3 INTERNAL PARAMETERS.................... 5
3.1 VLOG R 5
3.2 VLOg Qe 5
4 SAFETY ..o, 7
5 PQLOGVIEW. .. ... 8
5.1 Starting PQLog View ........ccoeeieirernnene. 8
5.2 Summary SCreen..........oeevveereeeeeeiveiennnnns 10
5.3 SpreadsheetMode ........ooovvviimiiiiineinnnin, 11
54 RMS Voltage...ccccoocoouiieeeeeeeee, 12
5.5 Statistics ceeveeereieciciiieeeiieee e 13
5.6 Dips and Over-voltages................c......... 15
5.7 Transients.....ccooiiiiiiciiiiniieieee e, 15
5.8 Harmonics .....ccccecveeeeerrieiinieeeeeeeeeeeeceen 16
59 Frequency.......ccoiiiiiiiieieeeee e, 17
6 REMOTE OPERATION OF VLOG
INSTRUMENTS ....cccoiiiiiiiiie e, 17
7 WARRANTY ... 19
8 OTHERPRODUCTS...........cccovcirriieeees 20

€

Issue 1. 07/01



emy



E VLog R Vieg Q
1. INTRODUCTION - = d
3 SPI‘:’Z ing 100-250V | 100 — 250V
V0Log plug in voltage recorders provide a fast and easy E - orage
solution to recording voltage trends and dropouts in ' Avg. RN!S value 0 ;(;;V 0 T;;V
accordance with the European power quality standard Resolution - -
EN50160. The products are extremely easy to use and Max. RMS value Yes Yes
plug directly into mains power sockets. Once the g ' i Resolution 0.5V 0125V
logging parameters have been set Viog will start to Min. RMS value Yes Yes
automaticaly store values dates and times which can Resolution 05V 0.125 vV
be downloaded to a PC for further analysis with VLog ' Number of 175.000
software. The advanced design of Vlog ensures ! ’ '3 events 32,000 ’
accurate recording of all parameters with no data gaps. Dips / Yes Yes
Interruptions
VLog R — measures and records RMS voltage values - . . 5ms
and dips down to cne haif cycle. : 3 Time resolution 5 ms m
! Voltage
VLog Q — records additional power quality parameters resolution 1V 0.125V
including transients and harmonics up to the 32" B Over-Voltages No Yes
i . ! Time Resolution - 5ms
Key features include: Voltage
. Continuous recording of all values with no gaps resolution - 0.125V
»  Clear graphical and spreadsheet summary of data s Frequency No Yes
with quick overview of key power quality i Harmonics \ Yes
parameters Measurement o (up to 32nd)
*  Min, Max, Average RMS values (1/4 cycle) with EN 601000-4-7 T Phase o
time stamps ' s 1 Neutral
» Actual transient display (>100 p S) with time N° of recording Phase to 2
stamp (Q Version) channels Neutral Phase/Neutral
* Individual harmonic and THD values with trends ' S to Ground
(Q Version) Transients No Yes
+  Statistical analysis of data according to EN50160 Remote
S operation via Yes Yes
* Remote access capability via an external modem ' s modem
PQLlog is the PC resident software for the VLog series
of Power Quality Monitors'. This software package
comprises of two separate applications,
PQlog Setup — Simple set up of internal clock, logging :‘ s
periods and intervals with default values for quick
results L
PQlog View — Data presentation showing RMS voltage ' :S
and harmonic trends, actual transients, summary ! )
information and statistics in accordance with EN50160
E = HIRE THiS PRODUCT NOW
WWW.INLEC.COM
FREEPHONE 0800 052 1110
' Note: For the remainder of this document, VLog refers ' s

to either product in the V0Log series of Power Quality
Monitors: V0Log R or VLog Q
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1.1 System Requirements

The minimum PC configuration to run PQLogView is as
follows:

. Available serial port

. 64 MB RAM

» Min. 10 MB Hard Disk Drive space.

. Microsoft Windows 95, 98, NT 4.0, or 2000

2. INSTALLATION

2.1 Installing the software

Before starting the installation program, ensure that all
applications are closed.

* Insert Disk 1 into the disk drive
+ Double-click on the “set-up” icon

+ Follow the on screen instructions until promoted to
enter Disk 2

e Insert Disk 2 into the disk drive

+ Follow the on screen instructions until instaliation is
compete

A Viog Power Quality Monitor folder wili be created,
containing two programs: PQlogView and PQlog
Setup.

2.2 Instrument connection

The PQLog Setup application will enable you to check
your V0Log unit. First, connect the RS232 cable into the
VLog serial port. Connect the other end to a free serial
port on your PC, and make sure VLog is powered.
When powered the VLog LED will flash every second.

2.3 Starting PQLog Setup

1. Click the Start button

2. From the start menu, point to programs, point to
PQLog, then click on PQLog Setup.

Your screen will display:

PQLog Setup 2.1.39

EEpTEe

Fig. 1: PQLog Setup initial screen

2.4 Selecting the serial port

On the upper left comer there is a dialogue box marked
COM Port. Select the serial port to be used for
communicating with VLog.

Once the correct serial port has been selected,
establish the communication by means of the Start
button. The screen will change accordingly (depending
on the Instrument connected).
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3. INTERNAL PARAMETERS
3.1 VLog
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Fig. 2: VLog R internal parameters

V0Log R dispiays:

. internal clock

. Block size for the measurement process
e  DIPIimit

By default, the block size is 10 minutes. This means
that every 10 minutes, VLog will record the minimum
and maximum values reached, and the average for the
10 minute period. The length in minutes of this period is
user definable from 1 to 30 minutes.

The DIP level is the value below which the voltage must
pass for a DIP to be recorded. By default, this value is
207V, (which is 90% of 230V, the standard European
domestic voltage), but it is also user definable. Users
not requiring DIP recording measurement can set to 0
(zero).

When the set-up process is complete, click the Finish
button. VLog R will then commence measuring (this is
indicated by the LED, adjacent to the serial port,
flashing).

3.2VLlog Q

Fig. 3: VLog Q internal parameters
VLog Q displays:
o Internal clock
. Block size for the measurement process.
. Recording Channel
+ DIP Limit
¢  Surge Level
»  Threshold parameter
»  Transient Recording mode

3.2.1 Block Size

By default, the block size is 10 minutes. This means
that every 10 minutes, VLog Q will record the fixed-time
events: minimum and maximum RMS values reached,
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the average of the RMS vaiues for the 10 minute
period, harmonics amplitudes and frequency values
(max, min and average). The length in minutes of this
period is user definable from 3 seconds to 240 minutes.

3.2.2 Recording Channels

V0log Q has two internal recording channels. The first
channel always measures phase-to-neutral voltage®.
Harmonics and frequency calculations are always
performed in Channel 1, which cannot be switched off.
In contrast, the frequency measurement function can
be switched off, if it is not required, or the user prefers
to save memory in order to record for longer periods.
Interruption recording can also be switched on or off.

The second recording channel can be set to measure
either  Phase-to-Ground  or Neutral-to-Ground.
Interruption recording can also be switched on or off.

3.2.3 DIP Limit

The Dip level is the value below which the RMS voltage
must pass for a DIP to be recorded. By default, this
value is 207V, (which is 90% of 230V, the standard
European domestic voltage), but it is also user
definable. Users not requiring DIP recording
Mmeasurement can set it to 0 (zero).

3.2.4. Surge Level

Similarly, the Surge level is the value over which the
RMS voltage must pass for a surge to be recorded. By
default it is set to 253V. (230 + 10%)

3.2.5 Threshold Parameter

The Threshold parameter defines the voltage difference
between the instantaneous voltages of two consecutive
periods that triggers a transient recording. By defauit it
is set to 25V, which typically triggers a small number of
transients per week in normal network conditions.
Users only interested in recording large transients
should set it to a higher value.

3.2.6 Transient Recording

The Transient Recording mode parameter enables the
user to adjust which voltage channels are recorded
when a transient is detected. By default, it will record
only the channels that triggered the transient. But it is
also possible to change this to record all active
channels, independent of which channel triggered the
recording.

When the set-up process is complete, click the Finish
button. VLog Q will then continue measuring (this is
indicated by the LED, adjacent to the serial port,
flashing).

2 In Norway and other countries Channel 1 measures
Phase-to-Phase voltage since electricity distribution is
without a neutral connection
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4. SAFETY

This product conforms to the latest directives
concerning safety and electromagnetic compatibility.

¢ European Low Voltage Directives 73/23/EEC and
93/68/EEC

* European EMC Directives 89/336/EEC and
93/68/EEC

Safety Standards

IEC / EN 61010-1: 2004/ 2. Edition: Safety
requirements for electrical equipment for measurement,
control and laboratory use: Part 1: General
requirements

EMC Standards

IEC/ EN 61326 Amendment 1/1998 for residential and
industrial areas.

Emissions : Class B
Safety instructions :

During operation of this appliance, certain parts inside
the enclosure carry hazardous voltages. Infringement of
warnings may therefore result in major bodily harm or
material damage.

This product is designed to be safe under the following
conditions:
— indoor use

~ altitude up to 2000m
— temperature 0°C to +50°C

— maximum relative humidity 80% for
temperatures up to 31°C decreasing linearly
to 40% relative humidity at 50°C.

This meter complies with the requirements of the above
safety standard for 300V Cat Il Pallution degree 2

Safety in its use is the responsibility of the operator
who must be a suitably qualified or authorised person.

Reliable and safe operation of this unit therefore
presupposes appropriate transport, storage, positioning
and mounting, as well as careful operation and
maintenance.

Operating and safety instructions must be followed.

This equipment is a direct-plug in unit and must be
plugged only in applicable and standardised sockets.
Distribution circuits must be fused.

If there is reason to believe that safe operation is no
longer possible, the instrument should be disconnected
and secured from unintential reconnection.

This instrument must be opened by trained service staff

7




only!

Safe operation should be concidered to be no longer
possible if the instrument

. shows visible damage

. has been exposed to a period of climatic
conditions outside the permsissible limits

. has been exposed to major mechanical stresses

If properly handled and treated this equipment requires
no maintenance. For cleaning the equipment must be
disconnected from mains! Only a moist rag with some
domestic detergent shouid be used.

Do not use abrasive cleaners or solvents. Do not
immerse the instrument in liquids.

5. PQLOG VIEW

PQLog View is a powerful application designed to help
the user get the most from the VLog Power Quality
Monitor.

5.1 Starting PQlLog View

1. Click the Start button

2. From the start menu, point to programs, point to
PQLog, then click on PQLog View.

Your screen will look like this:

Fig. 4: PQLog View Screen

PQLog View incorporates several toolbars which
provide quick access to commonly used functions.
These functions are also accessible from the Menu
Bar. All toolbars can be re-arranged by dragging them,
or make them ‘float’ over the application. It is also
possible to hide them by clicking the X' button when
‘floating'.

The “Comms toolbar” comprises of 4 items:

. A serial port selector. To choose which port is
used for communication with VLog.

. A checkbox to indicate whether a modem will be
used or not’.

3 IMPORTANT: Before using a Modem, make sure both
iocal and remote modems are properly configured, (see
section 6 ‘Remote Operation of VLog').
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¢ The Download data button. A connection will be
established with VLog, and all VLog recordings will
be downloaded.

» FErase Memory. This button will erase the Vlog
internal memory. The wuser is prompted for
confirmation of this command before data is
erased.

The “Main Toolbar” also comprises of 4 items, but only
1 is active at start-up:

+ Open data from File: To retrieve previously saved
data files from the PC hard drive.

The other 3 buttons are active when PQLog View has
data stored in memory:

. Save data to File.
. Print Current Screen.

. Print report. This produces a printed report of the
information on screen. It is possible to adjust the
report parameters.

** PllLog View 21. 30 - [C\WINDOWS\D esklop\My Biielcaze\LEM-H Sampte file.qzn)

Fig. 5: VLog Q Displaying 2 channels Neutral-to-
Ground voltage graphical data

In PQLog View, every file has its own window inside the
main one. This allows files to be open simultaneously
for comparison. Each of these windows has eight tab
markers, which are used to select different viewing
modes of the recorded data.

When a data window has been created, The ‘Graphics
tab’ is selected and the graphs corresponding to full
measurement period are displayed. New Toolbars
appear, and can change according to the viewing mode
selected. Their function will be explained in the
corresponding viewing mode.




5.2 Summary 5.3 Spreadsheet

This mode displays all the recorded data in tabular
mode. For every event or measurement, the recording
date is displayed in the left column. The second column
indicates the type of event or if it is just a timed
measurement. If the event is a dip, over-voltage or
interruption, the duration is shown in the third column.
After this, the maximum, minimum and average values
are displayed for every recorded channel. When a dip
is recorded, the minimum voitage reached is displayed
in the ‘Min’ column of the corresponding channel.

wq

The summary presents general information regarding
the monitoring process. There are 3 fields the user can
edit:

. Recording Location

;-

. Client Name

D Notes. In this field it is possible to enter up to 32kb
of text.

Additicna! information is also displayed including time
of first and last recording, recording interval, number of
recordings, number of recorded events.

If an over-voltage is recorded, the maximum measured
voltage is recorded on the corresponding ‘Max’ column.

When an interruption is detected, O is noted for
maximum, minimum and average measurements. A
transient is simply marked ‘Transient' in the affected
channels.

Kocatart {Dncns e

Frequency Measurements are also di§2layed in the
Max, Average and Min. columns of the corresponding
channel.

: PALog View 2.1.3¢ - {LAWINDOWS\Desktop\My BricicassALEM-H Saamis hle.arn) [-517]
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Fig. 7 Spreadsheet Mode
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5.4 RMS Voltage

In this case, the recorded information is displayed in
graphic mode. Since a graph is displayed for each
channel, the display can become over cluttered if
multiple channels are recorded, especially with small
screens. To avoid this, each channel can be switched
on or off with the ‘channels’ toolbar.

The RMS measurements are marked with red for
maximum, black for average and green for minimum. In
the ‘preferences’ dialogue box (Edit menu) it is possible
to specify the way the measurement points are linked
to form a line.

The recorded events are also shown using several
symbols. A green triangle pointing down represents a
dip. The minimum value reached is shown in a small
sign. A red triangle pointing up represents over-
voltages. A blue diamond represents recorded
transients and grey rectangles mark the beginning and
end of the interruptions.

", POLog View 2.2.5

Fig. 8 RMS Voltage
The individual traces for maximum, average and
minimum can be switched on or off with the appropriate
checkbox in the graphic control toolbar. The same
applies to the marks of the events.
In this mode, the ‘Events’ toolbar can be used to jump
to the next or previous event and also to go to the first
or last recorded event. When this is done, the data in
the spreadsheet mode will change accordingly.

The magnifying glass with a '+’ sign is useful for
viewing data with more detail; the displayed interval is
thus reduced. The magnifying glass with a -’ has the
opposite effect.
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5.5 Statistics

This panel displays a statistical analysis of the recorded
data. On the right side of the panel a histogram of the
data is shown. The height of a bar represents the
number of measurements that are in the voltage range
for that bar. For instance, the fourth bar in the
histogram above indicates that there have been 65
voltage measurements between 222.5 and 223.0V.

On the Ileft of the panel several statistical
measurements are displayed. From top to bottom:

. Mean value, which is given by the formula:

2 x[i]

N

where x[/] represents a particular measurement
and N the total number of measurements

‘[[:

«  Standard Deviation, given by:

N -1

where p represent the mean as defined before

» 5% percentile: the lowest value that is higher than
5% of the measurements

. 95% percentile: the lowest value that is higher
than 95 % of the measurements

. The % of values that are between nominal-15%
and nominal+10%

. The % of values that are between nominal — 10%
and nominal + 10%

. Minimum recorded value
. Maximum recorded value

Uniike the graphic panel previously explained, only one
channel can be selected at any given time. To reflect
this, the Statistics toolbar has radio buttons instead of
checkboxes. It is also possible to select which one of
the three traces (maximum, average or minimum) will
be analysed.

13
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Fig. 10 Dips and Over-voltages

In this panel a two dimensional histogram displays the
recorded dips and over-voltages. The bottom axis
represents dip depth and duration in different axis. The
height of a bar represents the number of events
recorded with that particular duration and voltage level.
For example, the highest bar on the graph above
indicates that 24053 dips were recorded with duration
shorter than 100 ms and voltage level between 195 and
207 volts.

The histogram can be copied using the ‘Copy’ function
in the ‘Edit’ menu.

5.7 Transients

PlLog View 2.1 3¢ [=15]]

Fig. 11 Transients

The recorded waveforms are displayed for every
transient detected. It is possible to browse the different
transients with the ‘Events’ toolbar. It is also possible to
switch on or off every one of the channels that have
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been recorded, by clicking in the appropriate checkbox.

When the transient panel is active, the ‘Export data’
item in the ‘File’ menu lets you save the transient data
for processing in other application. It is also possible to
use ‘Copy’ in the ‘Edit’ menu in order to later paste the
graph in a word processor or other application

5.8 Harmonics

B,

St~ wyew

TS S

Fig.12 Harmonics

There are two ways to visualise the recorded harmonic
amplitudes

. Histogram for the different harmonic orders. In this
mode, the average (blue bar) maximum (red
triangle) and minimum (green triangle) of all the
harmonics amplitudes are displayed. Also the
Total Harmonic Distortion (THD) is shown. Any of
these individual harmonics or the THD can be
switched on or off. Note that the time interval
analysed is as shown in the RMS Voltage tab,
which is defined by the “From” and “To” day
selectors.

. Time-evolution curves, in a similar way to the
RMS values. Note that odd harmonics (which are
normally larger then even) are plotted using
thicker lines. Individual harmonics, as well as the
THD, can be switched on or off. In this mode the
interruptions are drawn over the recorded data to
mark the fact that in those periods there is no
available data
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5.9 Frequency

Fig. 13 Frequency

The recorded frequency values are displayed as time-
evolution curves, in a similar way to the RMS voltage
{or current) values. The Colour convention used to
display the values of the frequency are; for maximum a
red trace, average a black trace and minimum a green
trace. As with all graphs in PQLog View, it is possible to
copy the figure in order to paste it into a word
processing document or other application.

6. REMOTE OPERATION OF VLOG

INSTRUMENTS

As mentioned previously, it is possible to establish a
remote connection with VLog using two modems, one
connected to VLog and one connected to the PC.
These two modems must be configured properly in
order for the connection to be established correctly.
The configuration should make the modem use V42
and V42bis protocols for data compression and error
correction. Most modern modems support these
standards.

Remote Modem: Configure the modem connected
directly to V0Log as follows. it should be configured to
answer the phone when a call is received, and to set
the serial port speed to 57600 BPS.

There are basically two types of modems on the
market; those who follow the U.S. Robotics set of
commands, and those who follow the Rockwell set of
commands. If you are not sure which set of commands
your modem uses, check in your modem's operator’s
manual to obtain the command to force the use of data
compression:

+ &K2: Your modem is U.S. Robotics or compatible

¢ %C2: Your modem is Rockwell or compatible

17




Once you have identified your modem, it is necessary
to initialise it. In order to do this, connect it to your P.C,
and open a communications program sgch as Windows
HyperTerminal. Make a new connectloq with 57600
BPS, 8 data bits, no parity bit and 1 stop bit. Type:

AT

Expected response€:

OK
The below table gives the expected responses for each

7. WARRANTY

The software is provided on an "as is" basis. The user
is responsible for the choice, installation use and
results of use. LEM does not warrant that the functions
contained in the software will meet the user's
requirements or that the operation of the programme
will be uninterrupted or error free. LEM does not
recommend use of the software for life critical functions
or for any application where a software error may cause
financial loss, damage or expense. LEM makes no

'C{! representation, gives no warranty and accepts no

modem type:
U.S Robotics Rockwell condition of any kind whatsoever either expressed or
and and implied, except as herein expressly stated.
compatible  compatible ‘ ﬁs LEM gives a limited warranty that the disks on which
You type: AT&FO AT&FO. it the programme is supplied, to be free from materie_al and
) OK workmanship defects under normal use for a period of

Modem OK 90 days from the date of receipt by or delivery to the

answers: ﬁ! licensee. In the event that the disks are found to be so

You type: AT&S0=1.) AT&S0=1. e defective within the said period, as evidenced by a

Modem OK OK proof of purchase receipt, LEM will replace them free of

answers: ; charge if the}/ are returned pt?stage pre-paid.

You type: ATMO&B1&K2  ATMO0%C2. (E Under no circumstances will LEM, be iiable for any
N consequential, incidental, indirect, special or exemplary
oK OK damages or other economic or physical ioss, even if

Modem ) LEM has been advised of the possibility of such

answers. damages and loss. Under no circumstances will liability

You type: ATYO0. ATYO. exceed the purchase price of the software.

Modem OK OK It is prohibited to copy the documentation and other

answers: e printed material. Disassembly, reverse engineering and

You type: ATQ1 ATQ1. (m reverse compilation of the software is prohibited. The

Modem (nothing) (nothing) software supplied by LEM is copyright.

answers: - The user undertakes to take all necessary precautions

You type: AT&WO. AT&WO. g: to protect the software from unauthorised copying,

i thin - distribution or use.
Modem (nothing) (nothing) .
answers: The Interface hardware is guaranteed for one year from

the date of purchase against defective material or
- workmanship.

If the hardware fails during the warranty period, at the

discretion of LEM, it will be repaired or replaced with a

o : new or reconditioned unit provided LEM is satisfied that
the failure is due to defective material or workmanship.

Goods alleged by the buyer to be defective shall not
form the subject of any claim for injury, loss, damage,
or any expense howsoever incurred whether arising
directly or indirectly from such alleged defects other
than death or personal injury resulting from the seiler's
negligence. No condition is made or to be implied nor
is any warranty given or to be implied as to the life or
wear of goods supplied or that they will be suitable for
any particular purpose or for use under specific
conditions, notwithstanding that such purpose or
conditions may be known to the seller.

After completing this, the modem should be correctly
configured. Switch it off and on, and make sure it picks
up the line when called. When this is successfully

completed, connect it to VLog.

Local Modem: Configure the modem connected to the
PC where PQLog View is installed as follows. It does
not need any special previous set-up, since PQLog
View sends an initialisation string whenever a call is

g

made.
The initialisation string is defined in the following table:

U.S Robotics and Rockwell and
compatible compatible

AT&F0QO&B1&K2 AT&F0Q0%C2

o

oM O O N OO OO W N R
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